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CodeScroll Controller Tester& AI2510] EtZl H{AEE SH= AlLIE2| 25 A HEHL| T}

» Texas Instruments Code Composer Studio
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1.1. Texas Instruments Code Composer

Studio

1. Controller Tester ZZ2XMEZ AMMSHL|C},
CodeScroll Controller Tester RTW(Remaote Target Verifier) + Target Plugin (x64)

o EHEE S ZEFREPR EIHIEM BW EEEH)
MZ ZHS7|(N) > A MR C/Ces ZEHFE
— E—
=7l Ctrl=W ﬁ‘ U HI LI =(CodeWarrior, Green Hills, NEC) C/C++ Z2EHE
= 27| Ctrlsshiftew | 8] HIFE 2RO2 C/Ces ZERE
= B = CodeScroll ZERE HHE C/C++ ZEHEE MM
HBE) N CPl RS LE C/Css BEME MA
2= HEKE) Ctrl+Shift=5 i WE MEESE C/Ces SEME AIM
OlZ B[ (Mm)... F2 [ RIVE2E C/C++ ZEHE
ME DX7|(R FS B RTV 2C B2 C/C++ ZEHE
H3AH 0|2 HERLZ|(W)... [ £ DY C/C++ EfZ IAE Z2EXE
dy THRE7I().. E° 2HICIE(CodeWarrior, Green Hills, NEC) C/C++ Ef2l Hj~E ZEFME
i YEYIO). il YC HEE22H (/Cs+ EfI HAE ZTEHE MM
=R AltsEnter | O3 7IEHO).-. Ctrl+N
EEXN
2. /435t Code Composer Studio toolchains AMEHSHL|C.
i B =z=== o X i
| Y o2mE |
N EEEES BETUL
Z=®= 05 [cCStes |
2% |C:Wct_w0rk5pace | |
EHO M= ||
| e EMC 02 23
CCS toolchain
O GCCaA
O VS2017
O V52019
(] GCC 4.7 (32bit) ASSE BEEASLILL
[l GCC 5.3 (32bit) TESE HEERISLLL
[l Microsoft Visual Studio 2010 (32.. XMESE BHES&LCH
O Microsoft Visual Studio 2010 (32.. AESSE MML|TSLDH
|
EHZ 2H
< OB LS (M) » EEG) e
= o =
3. BAEE A4 MU MeBiLICt
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| Are) C|BE - |D:ch5_w0rk5pacw12.?t95t | BOHE7|(B).
Ci=EE el
v [ 12 Ttest |-§E1 S oo |
launches :
_settings main.c
Debug

targetConfigs

= =2
| || =or=21@)...
M AU 825 IE IR ERE RS AR
174 ¥SS dEmsUL
< OIF(E®) CHEM) > HE@ 3z

4. oY 2YS 25 02| 11 A= S SE/6tH L2 HET} Y FL|CH

- a .
[ CCStest =3 o = - @u2 ¥ B ==z i =
§EZEmE §HAE NS YT BY BAEET
Rz 2R B4 GLCLEIET P e T TR T TR TR TN T T O T |
LHAE HEAaE % : & mainc 7 =] FuEaE BEHEE B E-* =0
ETEN ® e
" aine 1/0/01 100.0%
int waim(vedd) 3
e
} g =2 EEEE
B 17000 100.0%
~ (g Datauit Modula
v L maine
@ man
W dededed
B
an
an
O test
W testCCs
& Teuttttt
QExn AETE-N-EY..
FEECE ]

B 0

DN - * o= i@e- - &9k  --oeiiim]

5. OHHE AtE3t7| 25 Code Composer Studio, CodeScroll Controller Tester0f|A| A4 2 &FL|C}. At
Mgt Atet2 &2 ZA] Controller Tester C|H{7{ ALE 7t0|E 9| 51| &=9Q! Texas Instruments Code

—

Composer StudioS 2t StA| 7| HEEHL|C}.
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» Lauterbach TRACE32

* PLS Universal Debug Engine

+ ISYSTEM winIDEA Debugger

* |AR Embedded Workbench C-SPY Debugger
+ Texas Instruments Code Composer Studio

Page 5 of 78



Suresofttech User Guides - 3.4

2.1. Lauterbach TRACE32

Controller Tester= TRACE32 C|H{HE AtE5SI0] EIA HAEE & 4 Q&LICH
Controller Tester= TRACE322| cmm A3 ZEE ALE5I0] E}Zl S H0|A HAEE A5t Z20E 7S

C}.
TRACE320| M Z|5t= EFZ] 22 Lauterbach S14|0| | Of|A] &H0IEt 4 Q& LT}

- cmm AJBE A= MM A EF =S
» Step1: Controller TesterOf| M EZ! 2tA A
« Step2: E{7I HAE AlSH
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Controller Tester= cmm A3 E OIAUZ 522 A5t
omm AAYEES AT WYHE 4 U FR0= B2l Y
2 M4 4 Y B0l AFBATE 27 2

=]
M cmm A3 E 243 Y9 S AYStE EHA2 Of2fiet 2Lt

mpc5554, mpc5553, mpc5534, mpc556x, mpecs551x, mpc560xe, spc560bxx, spc560pxx,
spc560sxx, mpc560xb, mpc560xp, mpc560xs, spc563mb54, mpc5632m, spc563m60,
mpc5633m, spc563m64, mpc5634m, mpc564xs, mpc5668, mpc5674, mpc5644a, spc564a80,
mpc5642a, spc564a70, mpch567xk, spcs56hk, mpc5643l, spc56el60, spc56el70, mpc5644b,

PowerPC mpc5644c, spc564b64, spcb6ect4, mpc5645b, spc564b70, mpc5645c, spc56ec70, mpc5646Db,
spcb564b74, mpc5646¢, spcb6ec74, mpc5676r, spc56ap, mpc5746m, mpc5744k, spc574k74,
mpc5777m, spc57hm90, mpc574xp, mpc574xg, mpc574xr, mpc577xk, mpc5777¢, spc570s,
mpc5726l, spc572l, spcd74s, spcd8ne, spcb8eg, spcd8nn, spc582b, spcb8ec, spcb8nh,
spc584b, s32r274, s32r264, s32r372

mkw01, mkw20, mkv30, mkv40, mkv10, mkv50, mkm30, mklO, mkl10, mkl20, mkI30, mkl40,
mkI80, mk0, mk10, mk20, mk30, mk40, mk50, mk60, mk70, mk80, mac57d54h, mac71x1,
mac71x2, mac71x4, mac71x5, mac71x6, mac72x1, Ipc51u68, Ipc54xx, Ipc8xx, Ipc11xx,
Ipc12xx, Ipc13xx, Ipc17xx, Ipc18xx, Ipc21xx, Ipc22xx, Ipc23xx, [pc24xx, Ipc28xx, Ipc29xx,
Ipcd0xx, Ipcd3xx, imxrt1064, xmc1100, xmc1200, xmc1300, xmc1400, xmc4100, xmc4200,
xmc4300, xmc4400, xmc4500, xmc4700, xmc4800, tle98, s3fm02g, s32k, sbela, sbelc, s6j3

ARM

tc2dx, tc21x, tc22x, tc23x, tc26x, tc27x, tc29x, tc35x, tc37x, tc38x, tc39x, tc116x, tx1167,
tricore tx1197, tc1724, tc1728, tc1736, tc1762, tc1764, tc1766, tc1767, tc1782, tc1784, tc1791, tc1792,
tc1793, tc1796, tc1797, tc1798
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2.1.2. Step1: Controller Tester0j|A E}2] &t
A 2]
= O

Controller Tester2| Ef2! 22 A H|0| 2|0 M ClE{HS MEABHL|Ct TRHE0| MENEl S3|210] Tt 2|5}
= LA 55T TA|ELCH

ClHHAHE TRACE32= A gLICt.

b Freescale ¢ CodeWarrior-MPCSSxx » 2.6 » others ¢ trace32

MEISH YE0| Iet 2 S=5S0| EA|ELCH TRACE32 BHAHE AMEst= 890 2dslolsts &=2 oted

TRACE32 Alsimiel A2 QIL|C}. EFZIDICE AlSHIiQlo| Ct27| 20,

|
. o =]
trace32_exe_file_path AF25HE E1710] AIBHIICIO0| TH=32| BHOIIOF BHL|C}. TA 5+20]L|C}.

2T o—dg

EfAl 2tEF0| 2E517| 25t 8io|H 2| oY B2 Y LT} AESH= IDE &
target_binary_path = 2E ATEEO|M EHI BIO|H2| THYUO| ddsl= F2E &Qlstil
YH LIt T4 2Lt
chi AE3StE EFZIQ| ) 0|§S YHAYLILE cmm A EHES s 4de
> 0 AFZ%[7] W20 ZEtet 2 0|52 YHsHOF JL Tt
AH82} 2ol cmm ATZE Tl A2 YLICE cmm ATYE AL A
S 2|52 Ot= EFZI0I AQ0|= C|H A EFZ AR 3HAS MASH=
= A H = [ulln LS AL OoT [ |_ o= 20O [
user_defined_cmm_script_file_path AT2lES 25 7LL AFRSIT 9/ omm AJ2IE Tjol HZ = o
2430} SLict
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B2l E| AE S AR5t 20| A
BIAE UBIAOIE Hol m22
225101, EF2 EIAE
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A3

o°I"

zO| TRACE32 &==7] é‘!% iiOHOF
ZEHIAE Of| 70l A [E|-7| BHAE AlsH]

— =2 o
Us L.

II°|'

FLCt

MENBLILL B AE Ho| [M3] HES

rulo

2=
A=
AISHSH

EE
=2 2o2

A
&

TaﬂﬁEWMW|1

4 [ test!
I ME B 7| (N) -

X

@M
g

AR (D)

0|2 HIR7|(M)...
ItH27|(.
L{£LH7|(0)...

Delete

F2
g
[

ME A% 7|(F)
=Z=8E 2703

F5

e g

» ErZIHAE 4
3 ErZ HAE 2 71§27 b

FHHZE

nfm
o
Im

* EZl HAEZ
TRACE32 271

AlS#St i TRACE32 2 1240
ol Aze2 ZR2E LT}

AISHEIL|CE YA OR HAEY} SR E|H
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o

® N o

11.
12.
13.

EZlez 44 & RUHAE ROMEAE 0|4 232 = 'O F& gl 28
AFEA D2HES 2| YE 52 Controller Tester Z2HEOf| A ‘BRI &t Y0 55 2= 238
E 43
e 4Btz gl
Controller TesterOf|A| ZEAES 0| Y2 24 58
Trace32 A3 & cmm A3 FHE M (start.cmm)=2 €0 ‘debug’E A3l (Controller_Tester ZZHE

4 2/.csdata/target/start.cmm)

‘step’ HES 22I5H target.cmm AT E X 2I0IOZ 0|F
target.cmm It 2| Go.HII0|| breakpoint |4
Trace322| Var > Show Function 22!

HAE CfA 4 M & HE 22

0j| breakpoint 2|4

‘step’ HES S2IotH C{HZ ZAETH 100 A 2[5t
Var > Show Local.... 22I5lH X|HH40| 10| Bigt= A S &9l
Ol EOIER| Al

e AlRE

t

ol
rr
!
mjo
Jor
o

?I22 0ls
t

J

or
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2.2. PLS Universal Debug Engine (UDE)

Controller Tester= UDE C|HHHE AtE2ol0 EtA HAEZS & 4 JUSLICL
Controller Tester= UDEO|A| X|5H= C|HZA ATJZIEEZE AR50 E
A=

UDEO| HZ5t AtES 4= QU

-

EtZl 552 PLS =1 0[] Of| M &olgt 4~ Q&L Ct.

rr

Controller Tester0jA{= UDE 3L 0|A YES ALESHO] EFA HIAES SALICEH 27| W20] AME A}
= EIZ HI2E 3l 0| HA IAAHO0[AS 44Ok LT

T o —

+ Step1: UDE IDEQYA {3 ATO[A AAM
» Step2: Controller TesterOjlA] E}Z! &t A A A
« Step3: ElZ HAE AlSH
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2.2.1. Step1: UDE IDEOJ|A |3 AT|O|A AH/M

UDE= UDE desktop IDEO|A{ UDE 93 AT0O|AZ AIASHA QI L|CH.

1. ALEsts BHAO| g= 2 TS HEisto] I AH0|AS g RLItt.

Select Target Configuration

Last Used Browse |

Folder to browse :

{UDE 2X| Z 2WTargetsW j

Additional Filter:

Files in folder : [“ Show descriptions

B NXP XPC560P Mini Module with MPC5604P (Jtag)

Default New Copy Edit Remove

2. AT 0|50l A [File] > [Load Program] H{ES S2l5tH Hio|H2| IS 225 4 QUG LICt Ofmf HA
E IC2EE YT E Ho|H 2| TfUS MEHEHL|C},

— g
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File Edit Debug Show Views Tools Config W

[0 New Workspace CTRL+N
& Open Workspace... CTRL+O
kS Save Workspace CTRL+S
k2 Save Workspace As..

Save Workspace as Template...
H Save View Content As.. CTRL+ALT+S
= Close Workspace ALT+F4

Ell__oa d Program

. Connect Target System..

< Disconnect Target System..

Print Setup
Print

CTRL+P

Recent Files

Recent Workspaces

Exit

3. O|% QH{o| Tf2} [Program] HES -2 € g
HYHOR LB YIAAT0|A HYO| ARELICE [Exit]S 225101 22 WAHLISLICH

o o 11—

User Guides - 3.4

|20 M0f wtat o] 12| TUo| Ef20| EFLICH RET}

. UDE - FLASH/OTP Memory Programming Tool - Controller0.Core

—FLASH/OTP - Memany Dewvice

IPFIASH: 512 kByte OnChip FLASH
Index | Start End | Size |

i D00000000 (00007 FFF 32K
Dx00000000 Dx00000007
Ox00000020 Ox000002FF
Ox00001000 Ox00001147
Dx00002000 Dx00007FFF

1 Dx00008000 0x0000BFFF 16k,
Ox00008000 0x0000BEFFF

2 (00002000 [x0000FFFF 16K,
Dx0000c000 Dx0000FFFF

3 M00070000 (0001 7FFF 32K
Ox00070000 0x00013F78
Dx00074000 Dx000170D7

4 10N 200N MNNN1FFEFF sk

Remowe All

Remowe Sel.

LI [v Enable

Eraze ...
Frogram
Wearify
Hvs' Protect ...
SW Protect...
TestEmpty ..
Info ...

Setup ...

Exit

About

PRl

Help

General ...

[Erl .

Fragrarm All

d

Verify Al

AfM|eh Atet

2 UDEOIA H25te DS 22 5HIAIR.
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2.2.2. Step2: Controller Tester0j|A E}2] &t
A 2]
= O

Controller Tester?| EfZl 2t8 2 H[O|2[0| M E[HAHE HEAFLICH Z2HEO| HEIE S| Q10)| Tt 2[&S)
= HHA S=T EAIEUCL
C|#7E UDE 2 4y &LC.

b Freescale ¢ CodeWarrior-MPCS5xx # 2.6 » others ¢ ude

=0| EA|ZLIC. UDE CIHAE AtEste 320 €daliotet= &

ElZl St A Cs |5t gio| L 2| o
target_binary_path _ ~ 280 E=517] /2t 4012

H2QU|C} AFRSHE IDE Ei= UE ATRIEO
M EfZL HIO|UH 2| THE O] dd == OEE ghelotal YHEYLC) B S5y L
ude_project_file UDE IDEO||A] M=l I IATO|A T2 E T (.wsx) A= L|Ct T4 SE=QL|CH

Controller TesterO| M AtE5ts 7|2 AFEE

Efz7l 8t M3

+ visual basic script L|C}.
8 440| LT [OK] = [Finish]tHE%

SlgHCh EIL HAES

Page 14 of 78



Suresofttech

2.2.3. Step3: E}Z] HIAE
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& EMZIEAE 4
14 EfZHAE 27 FHHS7)

FHHZE

nfm
o
m
Im

goj| £

ofe UDE C|H{ZY A3 ELE C++, .NET, Perl 52| 9102
=%%EG%N%QM%WHWHEUDEW%
ME ERISHAI2.

A
St
o

2EAISH

=
5=

A
e

ub

(]|

PYN=]
E

o
EFZ HIAEZ A3t fISiAM= UDE IDEE =29t &E{0{OF & L{C}.
HIAE HH[A O Rl Z2HE HEAE O F0A [Et2 HAE ]S MEHSIAHL HAE Fo| [HH] HES
2205101, 2 HIAES 3T 4 UaLT
+ [EFEIAE M)
TR EIA~E LA 0|E Fg ¥ = 0
4 [ test!
N T b
¥ AHD) Delete
0|2 HHRLI|(M)... F2
Ry ZHHL7|(..
5 LHELEZ|(0)..
MEZ 30X 2|(R F5
ZEME ©|(5)
EX PP 3R »

AL|CH AQRIER ZHASH

2
Automation Basics A&
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N

© ® NGO N

EZlez 44 & RUHAE ROMEAE 0|4 232 = 'O F& gl 28
ANHEZL Z2HMES 2| YE 52 Controller Tester T2 AMEO||M ‘EF2] #F Y0 &

£ 48

Ye 4B3terl gl

Controller TesterO| M ZZHE S 0| Y E AL 22

Pls Ude Al & T2 HE MEH(\wsxItY)

20| M Y EE outputI}YS AMEH

ZIZ H|H|A|0]| M 0f| output THUO| SO Y= AA I} Sh4 HBE I BA|E= AS &9l

IAS Y Bt i SATI HEH £ 0] CIMY HAS A1

=
FoHES

[l

LE=20 entry pointOf| A
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2.3. iSYSTEM winIDEA Debugger

Controller Tester= winIDEA C|HH U AJZIES E5l| A} 5O 2 E}J] S HO A HAEE Adi5I0 ZIE J1HA
=758 A3
WinIDEA7} 2| l5t= EtZ] 222 iSYSTEM E1 0[] Of| A &H015t 4 Q&L

m

.

[
o
Im
10
nx
ogt

= winIDEA 22| A| &7} 22|%[= python SDKE 222 LT 2 22[E[0f U]
DK 22| HO|2] Of|M CI22EYS 4 ASUCH E5, AFESH= winlDEA B0 3T

2|45t Q=2 EQISHOF BHLICE Controller TesterOijA 7| 222 A|&5t= [/ A3 E= python

C

un oy O
P[>
)

_<
%)
_|
M
<
%)

<

w
w
£
2
o
N
[N
|0
Hu
IR
T

—_

O] 2XO0j|lA= winlDEAOA E2HEZ MM GH= Z{2E{ Controller TesterO| A E}2] HIAEZ A84517|7}2| Q]
WES Ol A2t S AHE LT
Ol A|Of| A= iISYSTEM BlueBox iC5000 Unit C|H{ {2t NXP2| MPC56xx EtZlS AF2EfL|CE.

* iISYSTEM winlDEA £ ALE3517| 2I6H At ZH|
« Step1: winlIDEA 2|3 ATO|A MM Ol M

» Step2: Controller Tester0jA Et7l StA M

o Step3: E}Z] E|AE AlSGH
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2.3.1. iISYSTEM winIDEA & AI25}7| st AFA
=

Controller TesterOf| M winlDEAS AF2310] EfZ] EIAEE 512{H winlDEAR} HESHH ALE 7t Tl A7t
I 28t ct.

A A= EFZ] HIAE 480 40| winlDEA 3 AL 0| A S AAMSITD AF2S C|H{HZE Controller Tester7| A %|
E PC2t HASHOF BLCt.
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2.3.2. Step1: winlDEA $|3AT|0|A MM A M

1
(@)
1. winIDEA Mgl = AMCHO|F0| A [File] > [Workspace] > [New Workspace...]& MEHGSIO] Al 22 HIA
HO|AE M-gefL|Ct. M/ dst JIAATHO|AZ Controller Tester Et2! HIAEO| AFESH| QoAM= 27t &
Z 9ol e
| w| winIDEA
File Tools Window Help
d  New.. Ctrl+N
& Open. Ctrl+0O
H Save "trl +
@ Save All
0 Page Setu
@ r Ctrl+F
Select Workspace...
Workspace
Source Control
2. Z HAYZ AT 0|70 M [Hardware] > [Hardware...] & 225t =, [Hardware Type] 0| HZE

BlueBox2| 22 MeygtL|ct.
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Suresofttech
Hardware Configuration

Hardware Type  Communication

Hardware
iC5000, MAGZ2k e

System Configuration

E A YAl MAELD [Test] HHES S2f 7|7| HZAS sl0IstL|Ct EA
of Cigt AY2 iISYSTEM BlueBox O+ U S 22 FHA|2.
X

292 [Communication] &40 A
A0 THE T 4H| A E Y

Ct
u}

Hardware Configuration

Hardware Type Communication
BlueBox Unit (serial number) ~
Port 5313
Configure...

Part
(®) UsE
) TER/IR IP addr
Use global discovery on UDP port 58371
BRIDGE Bridge
Device
IJSE and TCP connections #12345 notation can be used to
nrect to device with serial number 12345

SEB: For optimum streaming performance

E]n
- Always use quality cables
=, [Hardware] >

-
- Avoid hubs
- Perform comm. test from different host PC ports
i 25l 2ABHAIZ)
EXSHL|C}.

=
="
Zz22 A

ANoTTZ2 —Tid

4. At 045 2 [Hardware] > [Use Software Breakpoints] &
] ©| [CPU] S20M AR EF2

X
ol

O
[Emulation Options
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E] demo_workspace - winlDEA
File View Hardware Debug Test Tools Window Help

n Project Hardware... E —
= x |Filte License... o
=] Initialize =
E Emulation Options..
2 CPU Options. >
e Use Software Breakpoints @
= Use Hot Attach __E
] E
FLASH 4 5=
= o
= ELASH Setup.. _
— )
Analyzer Setup ;
Tools...
= Options...
Emulation Options >
Hardware CFU Initialization Initialization After Download
Famil POD/ICARD/TAG cru|
MPC56048
| e | MPC5604C
P
| SetDefaut | m
MPC56058
MPC5605BK
MPC56068
MPC5606BK
MPC56065
MPC56078 v
CPU wariant
(default) e

e EtZl ¥2 MO SHe MR S40| CHE 4 &L

5. 7|7 43S B LHH HAES HO|H2| B2E SSalj0F ZLCt. HA HAE O A4 FES HE
510 Hio|H 2| & A &L Ct. O3 2 winlDEAS| AT 0|5 [Debug] > [Files for Download...]0i| A
[New...]& MEASI D 247

HHfO|H 2| H2E IS UL

rol
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Download X

Download Files Options Target Download SMP  Endian VLE  Overlays

Path Type Offset

MPC5604P_Example¥tbintinternal_FL... ELF r

MNew... Remove Properties...

Memory area | default o

[ ]include project output file

Default file for debugging linternal FLASH.elf w

6. HIAMO|A HHO| ELIL, YA O[AF A ZSH0] winlDEA {3 AT O[A IHU(.xjrf)
UIAAHO|A T2 Controller TesterO|A winIDEAZ 0|25t EFZ] HIAE A& Al AIR

AI AL CY,

ocood

o

IL|C}.

il
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@ demo_workspace - winlDEA

View Hardware Debug Test Tools Window Help

w m+ 0O X

‘||III?|I“|W|I$I.'E|$E‘

File
1  New.. Ctrl+N
& Open. Ctrl+0O
| Save Ctrl+S
@ Save All
@ Page Setu
a P Ctrl+F
Select Workspace...
Workspace
Source Control
#  Find In Files...
Exit Alt+F4

O[A| EtZl HIAES 5t7] 218 winlDEA {3 AL| 0] A 440

B
& Open Workspace...

Save Workspace Template...

New Workspace...

Close Workspace

LLbA
E g

User Guides - 3.4
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2.3.3. Step2: Controller Tester0j|A| E}Z! 2}
A 2]
= O

Controller TesterQ| EZ]l HIAE T2 A E AHM OHA E= T2HE T ZIHE|Q| EFl &4
MEBHLICH Z2ME 444 Al el SX0l0) T2t Mei Jhs3 Clbi7| S20| YA,
C|HHE BlueBox 2 H&gL(Ct.

b Freescale » CodeWarrior-MPCSSxx » 2.6 ¢ others »  bluebox

olM EIHAES

M

MHEfSE 2O Ifef 28 &=5S0] EA[E UL BlueBoxE AtEst= 8700 285H0F ot= &

Jo

= Ofeff 2ot &

12 QI2AGHOf 5t= &2 Controller TesterOjA{ 2 Alo2 HA|E L|CH,

winidea_binary_path winIDEA A!3H T}l (winlIDEA.exe) 2= QI L|Ct. T4 2 QILICY.
winidea_workspace_file_path winIDEAO|M AM/AdSH I AT O|A T (.xjrf) 22 L C Z4 SHEQIL|CE.
Controller Tester0| A AI5H= 7|2 A3
8%, python2 2 2H/d5l{0F d 2ot Ef 2l B 2]
= d20|= iSYSTEM 2H0|2] £ 2t115t0{ 27t SDK Mz|E 2!
ERZl &tF 4E0[ ELIE [OK] E£= [Finish]H &
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2.3.4. Step3: E}Zl H|AE AlsH

EIAE UH|AOIE 7ol Z2ME AMAE 7oA [EI2 HIAE &S UESIAL HIAE

= (M|
22/5t0], Bt EHIAES A3 4~ AGLICH

- [EF2L BIAE A3
TH BIAE HH A 0| HE v =8

4 [ test!
b ME 2S7|(N) 4

K AH(D) Delete
0| = dp32|(M]... F2
B AHHZ7(0)..
ey WEWA0)..
MEZ X7 |(F) F5

Z=®E oH|(S)

sE e 4 »

® EfZEAE 4F

=y EHEIHZ2E Z1 {27 3

FHEZE

njm
ot
[ra
|m

st

2 91&LCt. Controller TesterOf|A{ E}
57| 210] BFEA| winIDEAE ZZ35}{O}

ofe WIinIDEAJ} A% 201 MEfoj M= B2l BAES 4
A L|C}.

=
2 EHAEES A

1% >
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Ofm
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il Ef2) BIAE C]tZ

N

©® N o s W

T

WinIDEA A3 & Y=t T2
[Debug] > [Download] ME{ 50
ASCHO| Run HES =20 C|HZ

F5 =2 Citf g 2y

W HAE FOM HAE AHO|A 228 = HHIO YE

AMB2t TRHEES 2IY YT 52 Controller Tester T2 EOj|A ‘E}2! 3+7"
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2.4. IAR Embedded Workbench C-SPY
Debugger

Controller Tester= IAR Embedded Workbench C-SPY C|HZ 7|52 Ealf AAs2=2 EtAl & H0 M EHAEE
Aeistd 20E MM RE 73 AlSE UL
C-SPYO||M 2| &3t= EtZl =52 IAR STHO[A] Of|A 2Heleh 4 Q&L Tt

Controller Tester0f|AM IAR Embedded Workbench C-SPYZ E}Zl H{AEE 5t2{H C-SPY C|HZA 7|58 At
¢ + s UHd 2287 LT AFEAt= Bt HIAE 3 H0|| IAR Embedded Workbench 24
EE MMSID AtES C|H Y TZE E Controller Tester?t Az|&E PC2} ¢ ASHOF L C}.

IARO|[A A|S5the LM E 25 S 52 AR 21 0[2] oM &let &~ AG LTt

» Step1: IAR Embedded Workbench T Z A E Al

o Step2: IAR ZZ=HE MA
« Step3: Controller TesterOj|A EFZ! 2t A A A
+ Step4: ElZl HAE AlSH
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2.4.1. Step1: IAR Embedded Workbench &=
HE AN

1. [File] > [New Workspace]E 22!6t0 A} K IAH0|AE MMt = [Project] > [Create New Project...]
£ 225t Z2HE O} (.ewp)S MG ESLICH ZZ2AHE OIS MMt LIH IAR Embedded
Workbench?@| [Workspace] 50| Z2HE 0|20| HEA|E/L|C}.
Workspace * O X

Debug o

Files O .
® sample_project-De... +

2. C}So2 T2HE| A|E CHAF AA I} SHEZ 383 510 [Add] > [Add

o = IT
=2 T fl
Files...|2 MEHSD, AIE CHAf A4 THUS 2IHEHLICE 27t % [Workspace] HOIA A& 122 27t8

=22 &
Waorkspace v 0 X
Debug e
Files o .

= @Wsample_project-De... «

tnain.c

B Output
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2.4.2. Step2: IAR Z2HE M
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R
DRHES M

o t
2l510] [Options...]& M

ﬂJl

B LICE

1. D2, [General Options]Oi|A{ [Processor variant]2 AZ&tL|C}. O|E S0,
olase
o

9| B DeviceE MEHSt & 2Z9| B}l Z=0||A 5

Options for node “sample_project”

Categony:
Static Analysis
Runtime Chedking
CjC++ Compiler Library Options 2 MISRA-C-2004 MISRA:
Assembler Target Output Library Configuration Library
Qutput Converter = o
Custom Build Processor variant
Build Actions
Linker (O Core ARMTTOMI ~
Debugger
Smulator |®0eice | |None l
CADT
i, Ocmsis-pack  MNone
GDB Server
T4et Endian mode Floating point settings
I-Link/)-Trace =
T1 Stellaris @ Little FPU Mone
Mu-Link O Big
PE micro D registers B ~
BE32 £
ST-LINK I—I
Third-Party Driver BES
TIMSPFET
TrustZone
TS DSP Extension 2
hode [Secure
Advanced SIMD (NEON)
oK Cancel

2. =2 Z [Debugger] 7tH| 12| 2 0| =
MEHSE B2 T2 9 PCE HZASHY!
M2 W8S dE L

o= =2o0od

B C-SPY CiH{Z 7|5 AL8 S 95t ZRME A
.I

Maxim

Mediatek
Microchip
Micronas
Microsemi
Milandr
MindMotion
MitsubishiElectric
NetSilicon
NordicSemi
Muvoton

MNXP
ONSemiconductor
Qorvo

Redpine

Renesas

Samsung
SiliconLaboratories

504, [Driver] 20| AL

»
*

»

»

¥

»

>

*

*

¥

¥ Other
> SPEAr

> STM32F0
¥ STM32F1
¥ STM32F2
» STM32F3
¥

»

¥

»

»

¥

¥

»

»

»

»

¥

>

>

>

STM32F7
STM32G0
STM32G4
STM32GB
STM32H7
STM32L0
STM3201
STM32L4
STM32L4+
STM32L5
STM32MP1

St 8fAl0)| w2t [Debugger] 9rE|ﬂa| 5t

STM32F401
STM32F405
STM32F407
STM32F410
STM32F411
STM32F412
STM32F413
STM32F415
STM32F417
STM32F423
STM32F427

STM32F437
STM32F439
STM32F446
STM32F469
STM32F479

B T ]

v v v v

5T STM32F429AG
ST STM32F429A1
ST STM32F429BE
ST STM32F429BG
ST STM32F4298I
ST STM32F4291E

ST STM32F42911

ST STM32F429NE
ST STM32F429NG
ST STM32F429NI
ST STM32F429VE
5T STM32F429VG
ST STM32F429VI

ST STM32F4292E
ST STM32F429ZG
ST STM32F429Z]
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Options for node "sample_project”

Cateqary:

Pt

General Options

Static Analysis

Runtime Checking
CfC++ Compiler
Assembler
Output Converter
Custom Build
Build Actions
Linker
Debugger

CADI

CMSIS DAP
GDE Server
I-et
Jink/1-Trace
TI Stellaris
Mu-Link

PE rnicra
ST-LIMNK
Third-Party Driver
TI MSPFET
TI XDS

Setup  Download Images Extra Options Multicore Plugins

Diriver

Setup macros

[ 1Use macre file(s)

Device description file

[1Cverride default

Run to

|main

Factom Settings

I-jetE MEASH B2, [Debugger] 7tEl| 22| 52| [I-jet] &
SOl et AH2 AHESEALA} Sh= IAR C{H A Ol &

= WESol M5 W8S
FIAI2.
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Options for node "c_proj"

Cateqgory:

s

General Options
Static Analysis
Runtime Checking
CfC++ Compiler
Aszembler
Output Converter
Custom Build
Build Actions
Linker
Debuagger
Simulator
CADI
CMSIS DAP
GDE Server
1-Link/J-Trace
TI Stellaris
Mu-Link
PE micro
STINK
ThirdParty Driver
TI MSPFET
TI XD5

ISE‘tUF" Interface  Trace Breakpuintsl

Factory Settings

Reset
‘Cunnect during reset {default) e
Dwration: 300 | s Delay after: 200 | ms
Target power Ernulator
Erom the probe [ Always prompt for probe
P selection
Leave on after debuggin
® 99'ng Serial no

() Switch off after debugging

[]Log communicaticn

$PROJ_DIR$Wcspycomm.log

Cancel

O[A| EfZl HIAES 5t7] fIEH IAR 224

Im
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2.4.3. Step3: Controller Tester0j|A{ E}Zl &t
A 2]
= O

Controller TesterQ| ElZl HIAE T2 A E MM OHA E= T 2HE T Z2IHE|Q| EFZl &4 MAO|A CIHAHES
MENBILICH Z2RE Ay Al MEIE SXQI0) T2t Me Ths et OB S=0| Dk,

IAR E|Q1S AESI0] Z2HE 4'd A, IAR C-SPY LI 7|52 AE3SHY| fIgiM= EIH A S ide2 S5
OfF gt

b IAR » ARM-Compiler b 5x b others b ide

HEiSH Y20 Iet 2 S5S0| BEAIEUCH C-SPYE AMEst= 820| 24slof ot= =2 ofefl Bt Z5

— 71— o
L|C}.
L4~ =2 AAHHOF 5t= &= Controller TesterO| Al &2 Mo = HA|ELCE

IAR Embedded Workbench C-SPY C|H{{E AtE A| 25t
. debug.general.xcl It ZZQL|Ct IAR T2 AHE MM A| ZZHE T}
cspy_debug_general_xcl_flle_Path o1 ewp)o| 2121l 21219 [setting] ZCIofl A4S L LICH B4 32
ol |__| [:_|>_
=]

IAR Embedded Workbench C-SPY C|H{HE ALE A| 226t
. . debug.driver.xcl I}Y ZZQIL|CH IAR Z2HE MM A| T2HE T}
cspy_debug_driver xclflle_path  ( ewp)ol 242l 9112 [setting] BEIO| 25 SHELICH B4 29
Lick.

—

0
ot
M

HI7t 2%tE

Bt &d 2¥0] EL4E [OK] £ [Finish]HES S YL EIA HAES |C}.
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2.4.4. Step4: E}Zl H|AE AlsH

EIAE WB|AH0|E Ho| T2 HE HEIAE O:0f A [EI2 HAE AR MEHSIHLL EHAE

A puy = [ |
22/5t0], Bt EHIAES A3 4~ AGLICH

« [EF2 BIAE M)
Tg |2 E LH| 70| HE& ¥ = 0

4 [ test!
[ ME BHSZ|(N) -

K AHD) Delete
0|2 HHRL7|(M)... F2
) 2 = Ve
1 WEWZ(@)..
ARE X 7| (F) F5

Z=®E oH|(S)

Zz @ er g

& EfZHAE 4

1w EEZIHZEE] 727 ’

FHEZE

njm
[k
[ra
|m
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N

o0 kW

/. Output I}YO| E

EtHe= 48 = ‘7R HAE FOM HAE #H0|& 238 = THO YL &I’ 2
0121 g ol
AMEA ZZHMEES 2H HE =2 Controller Tester Z2HE0|| A ‘EtZ] &t F’ 20| St LE A3 E
E 43
U 45t Sl
IAR Workbench 3 & HESI T2 ME Iotet= I AN O|A MEH (ewwItY
|

workspace FOl|A B|AE Ty gte7t Qe ALY ME 5, 2101 122 250 T ZoIE 2|

)

E
workspace HO|AH ZZ2HE S 2Z 2|, Options...& €0 Debugger 3= 0] A
‘main’22 2|0 U2 =0l
Attko| Download and Debug HHE S =2 ™ maing g ASH
F5 S2{M C|HZ ZEQIENIR| 2IEH5H0] CjH Y

unto M A3 &0l U
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2.5. Texas Instruments Code Composer
Studio (CCSv4 and greater)

Controller Tester= Code Composer StudioQ| C|HHE A5 EtZl HIAEE & 4 Q& L|Ct. Code
)2 AESHH Bt 2HHO|M HAEZS AM3lstn A1t

Composer StudioZt A|25t= C|HZA AT E(4.xHHEE 5
2 7}42L|C}. Code Composer Studio0f| ¢ ZA510] AFRSH 4 Q1= |
Studio Ui &S &QUSHYAI2.

0| @M= Code Composer Studio C|H 7 AFE'HE CtS2t 20| M HAZ L0 ALt

« Step1: Code Composer StudioOfA] T ZAE AHA
« Step2: Controller TesterO| A E}Zl 3t A
« Step3: E}JI HAE AlSH

Ol A|OI| A A2 S C|H 7= Spectrum Digital2| XDS560v20| 1 EtZ-2 Texas Instruments2| TMS320Q! L|C}.
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2.5.1. Step1: Code Composer Studio0j|A| ==
ZHE WA

1. Code Composer StudioS Al3list A Z2HE S MMTHLCH 2|42 050 A [File]-[New]S MEiSH
S0l ddt= HEfel Z2HMEZS MENSL|C) 07| M= [CCS Project]E 22ict0] Z2HMEZ A4 g
ArE3St= BRI T ZEE USt = [Verify]S S25tT, 422 HEL U= &ole
C}.

1
s

88 New CCS Project O X
New CCS Project @
Create a new CCS Project.

Target: <select or type filter text= ~ [#TMS320F28335 ™

Verify...

2. CIHAQtEZl HES &S = LI A 2= YHELICL OA|0fAM= C2000 Ti ZItY2HE AFEELICE
[Finish]E 235 7t @AM 0| A0 4 E LT

R
@)
9]
(0)]
|H
Hu
4
Im
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4 C28XX [C2000]

Project name:

v Tool-chain

type filter text

—

<

User Guides - 3.4

test

Use default location

~ [5 Empty Projects
& Empty Project
‘& Empty Project (with main.c)
& Empty Assembly-only Project

Location: | C:#cestudio wsitest Browse...

More...

~ Project templates and examples

Creates an empty project initialized
for the selected device. The project
will contain an empty ‘'main.c’
source-file.

& Empty PowerSuite Project
& Empty RTSC Project

Open Resource Explorer to browse a wide selection of example projects..
Open Import Wizard to find local example projects for selected device...

@

< Back Mext = Cancel

Code Composer Studio= Texas InstrumentsO|M 7| 292 X &5h= CIHAH 20| IR CIHAHE ¢ 2| ¥E

LT

« TI XDS USB (CCStudio default)
* BlackHawk JTAG emulator

» Spectrum digital
+ MSP430 USB

+ MSP432 USB

» Tiva/Stellaris ICDI

Controller Tester= Code Composer Studio|A| | 5t= C|HHHE javascript2 A0
Composer Studio®| Z2ME H StHO||AM EFZIDF T/ 2 M| HES &g £
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2.5.2. Step2: Controller Tester0j|A E}Z! 2+

24

1. Controller Tester Z2AMES MMSIHL|CI T2 HME MM Cict ZFA|S LIS £ 2A{9] [Texas
Instruments Code Composer Studio] 211 5FA| 7| HEZHL|CY.
2. HAE HH|AO|Ee 2HE 32 = [EH] > [Et2] HIAE] > [EIAl 2t HEHRL T [EH2 2H3]10
MEHI Y 88 & 4+ JUELCHL Z2HES Meh o MEHSH E4Q10] wat ME 7ts s ClH Aot A
4 2&=0| Eepyy .
3. Controller Tester2| E}Z! -3 -4 IO Z|Of| A CIHHE MEHGL|C. O A|0||A{= Code Composer
Studio C|H{HZ ALESH?| W Z0i| IDE Cl{H{AHE HEigiL{CY.
BTl ¥ C2000 ¢ 6.2 ¢ TMS320F28x Pk ide
4. Code Composer Studio YEE 517| IallA] EF2l &4 MZo| 2lc EHOj| TSt HEES ATL|Ct 2
‘doliof St= =2 Ofeff H2f ¢2H, Ol Ha =L .
B costest £ ) : : e o X
TH HAE O @ EtI HAE 4P M HAE JEF WEBUL +5CF B GAEE TIPS UL 48 Uo B B&F UG0H IHELE B G2EF ¥ & AsLDE - —
;j_ ol P TI M C2000 b 62 ¢ TMS320F2BX b ide EtZl B3 IS 7|
v EJ §2E E
E"f:;* gz g == ~2= 4
e =3 o
HY use_stdio_header false
7|EH use_std_string_header false
ide_directory_path CWtiecs920
workspace Diwees_workspace
project_name 12.7test
toclchain_kind tl
o 8:
=g =27 i
- YE Y He
ide_directory_path Code Composer Studio?| C|2IE2| A2 ex.C:\ti\ccs930
workspace Code Composer Studio?| IAALO|A ClHEZ| BZ
project_name Controller Tester0| M 24t Code Composer Studio Z22E 0|&
5. Al e
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B ccstest 4 o *
LH == = EFZI HIAE £3 )| HAE ACE WO SWFC e

=Y Ga

e b TI P C2000 b 6.2 b TMS320F28x b ide Ep2) §H3 1R 7
v B2l HAE =%

EbZ 83 -
Has 24 | | 0E S
1= cexml_path Dwccs_workspacest 12 Trest#targetConfigs#TMS 32072808 coxmi

e script_path
SlEr target_binary_path Dices_workspacest 12 TtestwDebugit 12, Trest out

debug_probe Spectrum Digital XDS560V2 STM USB Emulator
cpu_name C28xx

memory_page Memory.Page. DATA

char_format 5.

i=
i

char_format | S | a

ux
0

memory SI A| character
format DT YLICE 7|3t
252 A0 23,

device®] (2t 17 H& L8
ol 8 & Usun

C MY e
Code Composer Studio EfZ! 714 Itlo| ZZQIL|CH TZHE AH=Z 2} EFZIQ]
0| 50| 2=2| gelgfLct. mtUo| 0|E2 Code Composer StudioOfl A 45t
ccxml_path

EtZ19] O[S LICE.
Of|: {project_path}\targetConfig\{target name}.ccxml

LAJYES| F2E YL &
ct.

oL

. ATHET Qo B YAHSHA| giote
script_path

o >
o

Code Composer Studio 2 E A| MM E|= HiO|H2| O] A2 E QS LY.

target_binary_path . . B
Ol: {project_path}\Debug\{project_name}.out

Code Composer Studio propertiesOj| A Device?| &t £2& 2t115t0{ sHE Et
debug_probe A O MLl 0|5 YHELICE. (O A|2] AtRIO| A= Spectrum Digital
XDS560V2 STM USB Emulator)

-

ol

Code Composer Studio propertiesO| A Devicel| & 228 2t115H0

2 f
ZI CPU2| 0|52 Y& BILICL (CllA|2] AFZIOIAM = C28xx)

o Et
cpu_name

Code Composer Studio®| C|H {7t 2 758 memory pageE @ & &L LY.
AFZI 2t7)

— O

memory_page .
(Code Composer Studio Memory Browser

Code Composer Studio2| H|O|&{ ZLBH Z character?| =ME Y ELILCH.
char_format character?} al| @ Q| AT MEE] 6HR|O| A2, char_format Zf0| 55 &
ClauS=1C1=

« Code Composer Studio properties (Code Composer Studio ZZHE 222! = [Properties] >
[Debug] > [Device])
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Debug

debug_probe Cpu_narme

Device §Spectrum Digital XDS560V2 STW USE EmulatoriC2 8]

» Code Composer Studio Memory Browser

=¥ Disassembly @ Memory Browser & e~ Fep|ris
Data < |0x003rB100
Data:0x3fb100 - 0x003FB100 <Memory Rendering 1>

Character ~
8-Bit Hex - Tl Style index: 0 ~ X . . .. 0 . 3 . . . K . . . . Z . . . k
8-Bit Hex - C Style index: 1 . . . . . kwo.o X .. . . . 8
8-Bit Signed Int  index: 2 S e ., s L m » <+
8-Bit UnSigned Int index : 3 . L . .y o | 2 = v 7 '

_Bit Bi index : 4 3 - .3 m . ; . . . Q

char format Zt : 5 d . % . . p - N d . . . . . .

Packed Char roo / & . . . . . N . | . o R . . . *
16-Bit Hex - C Style % L] c i .
16-Bit Hex - Tl Style . . K H + i t { »
16-Bit Signed Int . e d H . X roo> + D
16-Bit UnSigned Int i1 E } 1 . . . 3 K . . . . . . . . { -
16-Bit Binary . Ft . K @8 . . C . . . 4 . m ; . .
32-Bit Signed Int . . . . . % . Cn . . . o d .o .1
32-Bit UnSigned Int .ooe L% . { B .
32-Bit Hex - C Style +F . . . . 1 R . . . . 8§ 7 K -
32-Bit Hex - Tl Style . . . 3 . T 7 F§ 1t b c . #
32-Bit Floating Point v . . 5 W Y # g ( K E

=

Al 24 0)| Al Code Composer StudioZt AT Qo™ AL o217t LrAdshL|Ct.

EtA

ot
oX

2Y0[ ZLHT [OK] £ [Finish]HES SHYLIL B2 HAES a8 FH|7t EXE UL
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HIAE BIAOIE ol ZR2HME HHAE B0l [EFR EIAE MIS MEfSIAL EIAE RO| [A3] HES

2510, EfZl HIAES 4dle o+~ UG LCH

Tg BI2E L4 0|} BE v= 0

4 |l test!
[ MZE PH=2|(N) 2

+ [EF2 BIAE M)

¥ 2HD Delete
0| Z g7 (M)... F2

g HE27[@..

1 HELRZ0)..

M= JX] 7| (F) F5
=ZE[/E V0

zz @ er g

» ErZIHAE A

% EIZ HAE =177 b

FHHXE
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m
|m

ofs CCSQ| OB AT ZIEIO| TSt ZFN|EH Z 2= Texas Instruments ZH[0|2] £ 2 D5HAIL.
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2.5.4. C|H 7= Soll EtZl HIAE CHZ

N

—

—
—_—

=

© 0 ® NGO A

Ef2L EHIAE TS R 23
CT_¢3Amo|A\.metadata\.plugins\com.codescroll.ut.embedded\Z Z A E H\TestFixture\cs A==
ol

notepad 2 s A2 Of2f0f Y= 2= OIL S| LHEO|M #line 2ALE //#line2 2 H A (#line -> //#line)
Code Composer StudioOf|M LHELH7| &l B E e 43

ClHA REZ ASHSHH cs_tfx.c I 2| main 40| break point?} A2|= A
Code Composer Studio Of| M 2= AT ‘File’ > ‘Open File’ 22l

2HO| A2 M HIAE S S testeAfb.c IR &7|(ex. zlibVersion_test0.c I})

‘Open File'2 E|AE CiAF §t40| 0|7} Qe AAIY R2f.c UL H7|(ex. inffast_1.c I}Y)
7E0]| QU= 514201 break point2 2|, 8&0] U= HIAE ChA §14-9] A|ZHR0] break point 2|
781 8RO M S U= THYO|M break point?} Ze|= AS &S 4= UAS(8Y2| 2 et Ho| AIRER
20i| break pointE Z| &)

ClHd =3

O]

—

njo
Jtok

Code Composer StudioOi|A{= Er2I0] S0{Zt &Ej] ZE=0t CIHZAE & &+~ UFLCL
5t Code Composer StudioOf|A C|H 20| 7ts¢t et F0| 0] UA| FF CHAS &
A oI LT},

T HA Y
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3. E}7] HlE Jjo|E

CodeScroll Controller Tester E}Z] T2 HE HE = ALZ25I0{ ElZ] HAE T EE Y C 5= @S oFLigiL|C.

* |AR Embedded Workbench IDE

+ Texas Instruments Code Composer Studio
» CodeWarrior IDE

» Hightec Development Platform IDE

» Tasking VX IDE

* Renesas CS+ IDE

+ MPLAB X IDE

* Microsoft Visual Studio

* GNU Compiler
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3.1. IAR Embedded Workbench IDE

Etal 2t8 2 HO|A|= AHEAt dElst S A0 Whet As22 YEIH 2| Y LT U8 7hse EH AL S
Fc 242 =24 2H0l| Tef FetyL

IAR Embedded Workbench 2HHEZ 35}17| 2|5HAM = E}Zl &
ot =S FE Lt A45l0fF o= =2 Ofeff Het 2o, 0|l T4 5Lt

EH
=

iz

Ao

cpu Processor variant2| Core0i|A] MEHSH 4= Q1= E}2IO| cpu

[ ]
T

C EH
=— d

IAR Embedded Workbench IDE & x| ZZ ex. C:\Program Files (x86)\IAR

ide_directory_path
Systems\Embedded Workbench 8.4

project_file_path  IAR Embedded Workbench T2 E I} (.ewp) A=

9| B2 S A4 L1 B B MY TOIAS Y2 HES -2 FPU F2I HIBE AP0l BAE Y
HIAO[E] T2HE OfA 232 -> S4 > EZL E|AE -> EI BFOIN CHI 3T 4 U
EF 7 43S 011D KU EIAE Ho| A% BES £201 Controller Tester0 A Ef BIAE ZES YCH

ofe stdio.h 9| 10 &4 A2 A| 2l0|E22{2| A% #iZo| LeFtc

IAAmojael ZZAHE 23l -> Options -> General Options -> Library Configuration ->
Library tab 2 Full2 HZAgL|C}.
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Options for node "test”

Categary
General Optons
Static Analysis
Runtime Checking
CfC++ Compiler
Ass=mbler
Output Converter
Custom Build
Buid Actions
Lirker
Debugger
Simulator
CADI
CMSIS DAP
GDB Server
Ijet
Minkf])-Trace
T1 Stellaris
Mu-Link
PE micro
STAINK
Third-Party Driver
TIMSPFET
TI1XDS

Library Options 2
Target Output
Library:

Ful v

Configuration file

MISRA-C:1998
Library Options 1

MISRA-C:2004
| Library Configuration |

Description:

Use the full configuration of the C/C++ runtime
library. Full loczale interface, C locale, file
descriptor support, multibytes In printf and scanf,
and hex floats in strtod.

STOOLKIT_DIR$Winc#cwDLib_Config_Fullh

(L] Enable thread support in library

Library low-level interface implementation CMSIS
None stdout/stderr
© v Use CMSIS
(O Semihosted Via semihosting
) ] DSP library
() IR breakpoint Via SWO
ok | Cancel
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3.2. Texas Instruments Code Composer
Studio

Bt &d 2 HO|A| = AEAtIt MElSE EX|Q10f Wet AAF22 YEIt A AY LT MBI Vtse T A &
Fo AU 24 280 T2t Fepy Lo

Code Composer Studio 2 =Z 5t7| Qo= EFA &4 A
FELICH 2dsliof of= =2 Of2 Eet 220, Ol B o=

B costest =4 O x
g6 925 4 @ B HAE HE M EAE DCE RERUL. +F2S B HASE TIFS UL 4B Y B BRE UGS B2 B2 GAEE B 4 AsUD - - v
B4 iy
T P TI» C2000 » 62 ¢ TMS320F28x b ide EfZ! =3 Ip%9 7
v EtZl g=E R
g Eag 5= 22u= A=
e g @
+E use_stdio_header false
7€ use_std_string_headsr false
ide_directory_path Ctitecs20
workspace Diwces_workspace
project_name 12 Ttest
toolchain_kind i
0| 8-
L=
ZgF g H

=]
=g

ide_directory_path Code Composer Studiol| C|2E2| AZ ex.C:\ti\ccs930

workspace Code Composer Studio?| ¥ AALO|A C|HEZ| B2
project_name Controller Tester0| M A4St Code Composer Studio Z2 X E 0|&

¢l =S AgstA| Zoti EfZl 2F 2y T0[R[9] = HES +E U F27I HEE FR0= HAE Y
HIZO[E{S] Z2HE Ot A 25 > 54 -> EfZ B AE > Ef FF0A THA| 28 + AS U

o =
n>
ot
]
ox
2
Zr
@)
(@)
o
D
@)
o
=
©
o
w
@
4
C
=3
o
J
n>
ot
m
<

QLB TS ofl2{7} AYBHLICY.

=2=od
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3.3. CodeWarrior IDE

EF2 8 A 3
2= SHQ B HYof ot ZaryLct.

CodeWarrior 2 EE 57| fIsi= EFAl 2t =H
2L A3i0f st B2 ofef BeF 2oni, 0l T4 YLt

e HIC EH
=2— d
ide_directory_path

ide_version

project_file_path

28 28 HO[R|= AL A7 dEfet SA|Ql0f Tt At 22 FETF 2 G U T =Y

tse B AL F

x
2
1o

c
In

LI'I:
=2
Rl

H
fo
rot
ox
H
ujn
ujo
2
s
_o'ﬂ
k-
rle
HU
mujn
ir
il
C
o

CodeWarrior IDE Ax| A= ex. C:\Program Files (x86)\Freescale\CW for
MPC55xx and MPC56xx 2.10, C:\Freescale\CW MCU

IDE H#, Classic == Eclipse

o
‘g Al 2H=0{2 .project O}

Classicl| A2 T2 ME 4 A| HHSE mcp O, Eclipsel| 42 T2 E 44

SY HO[R|9| B HES +E FRL F=7H Y
>E 4 Z

F2olE BIAE 1
Off M CHA| A28 4

A o
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3.4. Hightec Development Platform IDE

Etal 2t8 2 HO|A|= AHEAt dElst S A0 Whet As22 YEIH 2| Y LT U8 7hse EH AL S
Fc 242 =24 2H0l| Tef FetyL

Hightec IDE 2EE 57| floliM= Ef2l 2H8 232 2E HojM Eost Y2528 Yot /28 S5 &
g3liOF Stz =2 o2l et 220, Ol= B4 3Lt
e HIC EH
=2— dJ
ide_directory_path Hightec IDE 22| B2 ex. C:\HIGHTEC\toolchains\arm\v4.6.5.0

project_directory_path HighTec IDEO||A] M/HSt T2 ME C|2E{2|Q] B2

H0|z|9] &= HES
E

2 _"—_E
HIHO|E{Q] ZRHE DR A 232 > E4 -> EF2l HAE > E}2l &

deL =01 HEE d4R0l= HAE U
AR g

of

2
il
=
ux

=20 Controller TesterQjjAo E}Zl HAE BEZ HIESH

ujo

B2l 8tE 23S 02| 7T HIAE 7o Hl HE
|
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3.5. Tasking VX IDE

EF2 817 4% T0| 2| AFS A} MeEt SH 210 W2t SO R HEIt HAYLICL Mel 58 Cibie] 3
2E SH9l BN 23| mat gLt
Tasking VX IDE IEE 517| QIsAE B B3 3| UC S04 Lo FHES Y2A5in Y=E 5L

[=]
Ct. 2{43l{0F of= =2 Ofefl Eot 22, Ol B4 5L

oo U

« HIC EH

=2— d
ide_version A 2| %=l Tasking VX IDES| A
makefile_path Tasking Z=2 M E0f 244 =l makefileQ| H=2

Tasking VX IDE7t A x| &l ClAIE2| A2 ex. C:\Program Files

ide_directory_path
(x86)\TASKING\C166-VX v3.1r2

9 =S 49 A g Ho[R[o] 2R HES & 4L 427 HEE 40 = HAE U
HIZO[E{ o] Z2HE OtRA 238 > 54 -> EfZ HIAE > BRIl SF0[M CHA| 288 + AS LT

Ef2 817 42 0121 QU BIAE Ho| A% H{ES 28 Controller Testerd|A] 2 BIAE BEE WC
L|C}.
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3.6. Renesas CS+ IDE

m

&3 2438 HojR=

rr »N

qu

=

Renesas CS+ IDE
L|C}. 24 35HOF St=

=1
=
St
[=]

e HIC EH
=— d

ide_directory_path

ide_kind

workspace_path

23 ARt e = A
=412l 24 2Z0ol| Tef ety

S2 57| SIshME B 2
22 of2f Eet Zo0i, 0l T4 F2YLC

Q0] Tet Ats 2= YEIT A Y LT e Thstet TH A2l &

e
N
iz
2
>
ne
x0)
ro
ox
HT
uin
njo
1o
il
_o'ﬂ
[
re
HU
i
qr
o

Renesas CS+ & xz| C|2E2| AZ ex. C:\Program Files (x86)\Renesas
Electronics

IDE 22(CS+)

Renesas HEW IDEQ| 20 T 35lB2 =2,

project_file_path

O
o
>
=
=
S
o)
=
_|
o)
n
28
)
-
=2
R
m
>

«%s Controller Tester0O| M E|AE _?_E%%
E|-7| |:_-||/\E :H:E HI: |.7|
RoteE M4 oHO|: o,:,H_| ct.

- Build Tool2| Property -> Compile Options -> Preprocess -> Additional include paths O
M ofeiel A2 7t

(CTWORKSPACE) \.metadata\.plugins\com.codescroll.ut.embedded\ CT project name
\TestFixture

(CTWORKSPACE) \.metadata\.plugins\com.codescroll.ut.embedded\ CT project name
\TestFixture\cs

=ECELEEE

g
_I_
rr
A
o =
=)
()
(%2}
Q
(72}
(@)
CD
+
)
Hu
2
Im
2
=P
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0 S o P 4| e T v e an

Fath Edit =

Fath(One path per one lin): 14

Y'com codescroll ut embedded W RenesasCSPlusRLTE_2'W Test Fisture
¥com codescroll ut. embedded WhRenesasCSPlusRL7E W Test Fixturetes|

Browse...

[ ] Permit non-existent path
Include subfolders automatically

Flaceholder:

Placeholder Value 2

ActiveProject Dir C:iUses WSUREW Documents™WTEST

ActiveProjectMame  TEST

BuildModeMName Default Build

MainPraject Dir CAUsesWSUREW Documents™WTEST

MainProjectMame  TEST W

£ >
OK || Cancel || Heb
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3.7. MPLAB X IDE

EFX £17 417 H0|2) = AFB2P7} AeEt SAQl0) wef RIS 02 It MAUYLICH Mel Jhsdt Cluizie) £
S S0 24 M| Kt ZryLch

MPLAB X IDE Y= 2 57| 9lafiAl EI2l 8% M¥o| U= QoM LRst 2SS Ysin #=E S5t
2L A3iof s B2 o2l Bef 2oni, 0l T4 YLt

MPLAB X IDE &x| AZ ex. C:\Program Files (x86)\Microchip\

ide_directory_path
MPLABX\v5.35

project_directory_path MPLAB X IDEO||M 45t ZT2HE C|2lE 2| B2

¢l =S 2gstA| Zoti EfZl 2F 2y TO[R[2] = HES =2 U d27I HEE dR0= HAE Y
HIZO[E{ o] Z2HE OteA 23 -> 54 -> EfZ HAE > EfZl F0M THA| 28 + UASUT
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3.8. Microsoft Visual Studio

23 28 H O[] = AFEAR7E dEfeh SA|Ql0f Tt At 22 FEIF 2 HUCH U8 Vhset CHA &

= O °
ol 24 240 tef FefgUch

m

rr »N

=

qu

L

T
i

Microsoft Visual Studio

IS2 517] QIBHAE EF2L 817 Aol U SojH LR YESS YD ¥R
FEUICE 250t st B2 :

o
S Ofef #ef 220, Ol 24 ¢=YUCh

=

o py

e HIC EH
=— d

Microsoft Visual Studio A2| Z=Z ex. C:\Program Files (x86)\Microsoft

ide_directory_path . )
Visual Studio 10.0

build_configuration CH4 &M

sin_path Cia 2240 Y A2 (.sin THY)
9l F2 MR R5H1 EZL B 4 HOR YR HES 2 AU AR HAE A0l HAE Y
BIAO|E{S] T2 HE OIRA 23F8 -> 54 -> EHJ HAE -> BRI &HFO|M CHA| 8 &+ AT
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3.9. GNU Compiler

A0 Thet AAs22 LI YL U8 7hsT CH AL F

Btz 2t8 2 H0|x| = AFEAt dEle
Fc 242 =24 2H0l| Tef FetyL

=— A

GNU Compiler £E 2 5t7] 2JaiM = EI2 82 43o| YT eofl i W5 YR SS Yaistn =S FELCh
24430} St S22 Ofef Het 2o, 0= T4 3

o

makefile_path A7} 2-4 5t makefileQ| A2

¢l =S 2GR Zot EfZl 2F Y TO[R[9] = HES =8 U d27I HEE dR0= HAE Y
HIZ|O|Ee] Z2HE OIA 238 -> £4 -> EtI HIAE > B2l SHF0|M CHA| 28 & UASLICE

Eb 212 4HS 012D R4 BIAE Ho| A3 BES =28 Controller Testeroj|A] E}2 HAE =2 UEF
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4. |:|-E A|-.9.x|-g|. II EZ-IIE c>_|_|_3|.7

CodeScroll Controller TesterO| A AI25H= T R2AE S = Al2tl 29 4~ Q&L T
Controller Tester 3.3 O|M0Me= [EZ2HME LHELY|], [E2HE 714 27(] 7|58 A2 &L T}
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Controller Tester 3.3 O|ZEE{ = [EZ2HE LHELYY|], [EZ2HE JIH V|| 7|sC 2 &4/H Z2HMEZ /%

4 ALt
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ZRME MY EHAES EBSI0| TZHES LY 4 YLt
Ol ! Hl w0l A [Th] > [LEWZ[1E S U WELHZ| OFgAL
u_I.CH(FJ ,qxI(EJ ""M(A] ﬁi;‘“E(P] ga RJ é
ME =71(N) ?
T 7((C) Ctrl+W
== = T} Ctrl+Shift+W
HHEHE) Ctrl+S
BE HEHE Ctrl+5hift+5
Ol HHR7|(M)_ F2
MZ 3X7|F F5
HI2H 0|2 HFZ (W)
g 2 L ()
ey HEWZ10)..
EMR) Alt+Enter
T=(
2. [¥HH > [ZRHUE YRS S2FLC
L EETE = @
= A
EEWME 43N HES ET5IH ZEHMES L{HWL|C H
L CHat H sy
E2E H=E o
> = HEF
a (= gt
= EERE R
> = FH A
> = H=E
> = EE 23
< OIH(E) L&) #He
3. WEU7| e Z2HE) i A2E Meist &, (2] HES 2
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Po=mE YRy
=FHE L& L|7]
EENE 4HNE-ES EEH EEMES WL
A2E = 0= EEHE
zlib D& A E(E)
D& dE aH (D)
17 8 19E d¥3 Lt
HE: | CAUserswcodescrollWD esktopwexport 2O I|(S)...
temv- |[L#E® [ #=
4. UEWH F20 HELY|ot Z2HE 0|F0| Zetel SE7F 7l A
SFotLA} of= AFEALS| ARE 2 FALICH
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4.1.2. TEHE 7}24Q 7]

OD2HE JtH27] 7|5 0|&5t0, tHE PCOIA UEH Z2HMEZS IAHO0[AZ VA= + UFHCH

?E'H_l' OZHE 72 27]

ol ol wOll M [TH] -> [PHH27(1E 22U 74 27| DHEAH 2-L T
AR | BUE TME) EZEEMER) 4TR

MEZ ZHE7|(N) »
Z21C) Cirl+W
gs 270n Ctrl+Shift+W
HES) Ctrl+5
2 HEhE Ctrl+Shift+5
OlZ 87 1(M).. F2
MEZ 03 7|(F) F5
I AT 0] HHELZ| (W)

e THEE2().

e WEW?0)..
EH(R) Alt+Enter
EE0

2. [U8H] > [ZRHE YIS 22 F [C43] HES 2YTLICH
3. [ROIEY|] HES S5t WEH Z2HEo| i st= C|HE2|E 25U T
4. C|AEe[E M Eﬁ%fﬁ M7 2HE YE22H SAQ0| Ats22 MElELCh 5Yst 0|5e| 22
HET} 0|0] YIAAHO|A0 ZASH= 3%, Z2HE 0|§2 £=ddlofF LT
B x| [= =r=]
Z2HEE 77| ——
_ .=_ / 7
HEW ==HMES FHHELC 7
SZME O2EI: ChprojectlE_20200513113853
ZEHEE Q=2 projectlE
oIx): Chlsers\vagrant\Desktop\workspace\CTh3.3_rt
SR8
712 701 0/2 . 3
] GCC 4.7 (32bit) TFECE MM =Lt
GCC 5.3 (32bit) RECE MMEUALICH
ol = E
<o@@ | o= || 2=e .
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oo V2 T2AHEO| 0!
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[CHEHES 2
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o, 32
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ZRHE

St
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@ |EIHA
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A It Z2HEQ| S 42

WO 2 FA|G]

Z2(SYWA )

Chwrong_pathlzlib-1.2 11%zlib-1.2.11\adler32.c
Chwrong_pathlzlib-1.2 11%zlib-1.2.11\ compress.c
Chwrong_pathlzlib-1.2 11%zlib-1.2.11cre32.c
Chwrong_pathlzlib-1.2 11%zlib-1.2.11" deflate.c
Chwrong_pathlzlib-1.2 11%zlib-1.2.11\gzclose.c
Chwrong_pathlzlib-1.2 11%zlib-1.2.11\ gzlib.c
Chwrong_pathlzlib-1.2 11%zlib-1.2.11\ gzread.c
Chwrong_pathlzlib-1.2 11%zlib-1.2.11\ gzwrite.c
Chwrong_pathlzlib-1.2 11%zlib-1.2.11\ infback.c
Chwrong_pathizlib-1.2 11%zlib-1.2. 11\ inffast.c
Chwrong_pathlzlib-1.2 11%zlib-1.2 11\ inflate.c
Chwrong_pathlzlib-1.2 11%zlib-1.2. 11\ inftrees.c
Chwrong_pathlzlib-1.2 11%zlib-1.2. 11\ trees.c
Chwrong_pathlzlib-1.2 11%zlib-1.2.11uncompr.c
Chwrong_path'zlib-1.2 11zlib-1.2.11\zutil.c

[ <omE |

Cr2(N) >
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B 7tme0) o eS|
Z2EEQ ESE HZ =9 ’_b_j
I S=1% ®e 220157 ; y

[

15748 =7t =T E 2L

BE(EHWA F7)
Ci\correct_pathzlib-1.2.11\zlib-1.2.11%adler32.c
Chcorrect_path\zlib-1.2.11\zlib-1.2.11\compress.c
Ci\correct_pathizlib-1.2.11\zlib-1.2.11%cre32.c
Ci\correct_path\zlib-1.2.11\zlik-1.211\deflate.c
Cih\correct_path\zlib-1.2.11\zlib-1.211gzclose.c
Ci\correct_path\zlib-1.2.11\zlib-1.2.11%gzlib.c
Ci\correct_path\zlib-1.2.11\zlib-1.2.11%gzread.c
Chcorrect_path\zlib-1.2.11\zlib-1.2.11\gzwrite.c
Cicorrect_pathzlib-1.2.11\zlib-1.2.11%infback.c
Ci\correct_path'zlib-1.2.11\zlib-1.2.11\inffast.c
Ci\correct_path'zlib-1.2.11\zlib-1.211\inflate.c
Ci\correct_path\zlib-1.2.11\zlik-1.211\inftrees.c
Ci\correct_path\zlib-1.2.11\zlik-1.211\trees.c
Cih\cerrect_path\zlib-1.211\zlik-1.211Nuncompr.c
Ci\correct_path\zlib-1.2.11\zlib-1.2.11%zutil.c

F2l &L

ol

Yo =2 oy Z=2 YAo| ot BR0ls FRIt RETH| HEE HAL

8. [gRIHES St

RTV Z2AE J712{2 7|
RTV C/C++ T2AMEL Qb C/C++ TRHE JIHQ 7|9t SUSH HHHO R JIHS £ Q&L|CH

—

1. OQ! o0l M [IHE] -> [P R27(1E S ELICE 7P 7] DFEAOIA [2EH] -> [Z2HE JtH2 T[] o

et [CHS]2 SSLCt
2. [OIE7V|] HES 22I50] 7t T2HEQ| C|E 2|S MEISHL|CE C|2E{2|E MENSIH J1A 7|8
D2HE YE2L2E E4Q10| AH522 MEHEIL|CE [CIS] HES 22§ Ct

Y% M8 Z2MEQ =Y
2 RTV M| 2 E32 A

3. J1HQI|E T2HEN BHE 44 F2E HUT 4 YSLICL REGIA YL F2E WO BAlg
o, 22 32 22Ysi0] 2 & USLICH
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